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Тема урока: Раскрашивание контурного изображения в программе Photoshop.
Цели: 
· Обучающая – закрепить теоретические знания; сформировать  профессиональные компетенции  при раскрашивании контурного изображения   в программе Photoshop;         
· Развивающая – развивать способность к анализу и обобщению, самоконтролю, самооценке;  анализировать учебно-производственные работы  с целью достижения лучших результатов, уметь применять теоретические знания на практике.
· Воспитывающая – формировать у учащихся  способность к  самостоятельной работе для достижения совместных целей, стремление  к развитию профессиональных способностей  и мастерства; личностные качества (исполнительность, внимание, трудолюбие).
Задачи:
· Определить  значимость инструментов основной палитры;
· Обучить учащихся командам, с помощью которых осуществляется раскрашивание контурного изображения;
· Показать пример раскрашивания контурного изображения;
· Проверить усвоение материала.

Метод проведения: Практический
Материально-техническое оснащение урока: персональный компьютер с устройством ввода информации (клавиатурой), раздаточный материал,  наглядный материал, презентация к уроку, Photoshop.
План урока:
Организационный момент (1-2 мин)
Приветствие: 
Здравствуйте, ребята!  Мне очень приятно вас видеть, надеюсь эффект нашего урока будет зависеть от нашего взаимопонимания и слаженной работы.
1. Водный инструктаж. (40 мин.)
Сообщение темы и цели урока (слайд № 1, № 2).
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Слайд № 1
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Слайд № 2
Фронтальный опрос по теме «Photoshop».
· Для чего предназначена программа Photoshop. (Photoshop – программный продукт,  предназначенный для работы с растровой графикой)
· Перечислите основные  компоненты рабочего окна программы. (Основное меню – рис 1., палитра инструментов – рис. 2, панель параметров – рис 3) 
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Рис. 1
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Рис. 2
[image: ]
Рис. 3.
· Что называют пикселем? (Пиксел (pixel) - элементарная единица изображения в растровой двумерной графике. Это мельчайшие точки, из которых  складывается изображение);
· Дать понятие термину -  разрешение. ( Разрешение (resolution) - количество точек на единицу длины (дюйм, сантиметр). Один из основных параметров изображения. Чем выше этот показатель, тем качественнее изображение. За норму принимается 72 пиксела на сантиметр, но для получения действительно качественного результата, например, в полиграфии, необходимо значительно больше).
· Внимательно посмотрите на внешний вид основного меню. Оно состоит из подменю. Перечислите,   в каких случаях пользователь может пользоваться данными элементами?
· File (Файл) - этим меню приходится пользоваться в основном в начале и в конце работы, так как большинство его функций связаны с созданием, открытием и сохранением файлов;
· Edit (Редактирование) - в этом меню находятся основные команды редактирования, многие из которых есть и в других программах: Undo (Отменить), Paste (Вставить), Сору (Копировать) и т. д.);
· Image (Изображение) - подменю, созданное для работы непосредственно с изображением. Многие его команды применяются  почти в каждой работе.
· Layers (Слои) - работа со слоями.
·  Select (Выделение) - создание и редактирование выделения.
· Filter (Фильтры) - в этом подменю находятся фильтры - дополнительные модули Photoshop,
выполняющие самые разные функции.
· View (Вид) - различные настройки интерфейса, помогающие пользователю в работе.
· Window (Окно) - с помощью этого подменю вы управляете отображением палитр и размещением документов на экране.
· Help (Помощь) - команды справочной системы.

[image: ]
Слайд № 3
Объяснение нового материала.
Практически каждый человек,  работающий на компьютере сталкивается с необходимость оформления своих документов рисунками и рамками, создания поздравительных открыток своим знакомым или выполнения   работ по черчению и проектированию. На сегодняшний день существует большое количество различных программ для работы с изображением.  Самым популярным на сегодня  программным продуктом  является  Photoshop. Популярность этого продукта объясняется простотой и удобством работы, палитрой инструментов, позволяющей рисовать  в графическом редакторе так же, как и на бумаге.
· Что, по-вашему, является контуром?  
· Где и в каких случаях используют контур? 
	Часто создавать  изображения  приходится  с нуля. Как правило, если это сложный объект, сначала рисуется его контур, а затем он раскрашивается. 
Нам сегодня на уроке необходим  лишь процесс раскрашивания, поэтому мы воспользуемся уже готовым контурным изображением. 
Давайте посмотрим небольшой видеосюжет (слайд № 4).  Как вы считаете кто герой нашего урока?.....
Правильно -  мамонтенок. Контурное изображение именно этого героя мы и будем раскрашивать на уроке  (слайд № 5)
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(слайд № 5)
И перед  тем как приступить к работе, мне бы хотелось вам напомнить те периферийные устройства, с которыми нам придется работать на протяжении урока и правила безопасного поведения  и работы в компьютерном классе (видеосюжет, слайд № 6)

В куртках, шубах и пальто,
Не приходит к нам никто.
В грязной обуви друзья
В кабинете быть нельзя.

Оглянись, дружок, вокруг!
Вот компьютер – верный друг.
Он всегда тебе поможет:
Сложит, вычтет и умножит.

На верху машины всей
Размещается дисплей
Словно смелый капитан!
А на нем горит экран.

Если вводишь ты «ответ»,
А компьютер скажет «нет»,
По дисплею не стучи, 
Лучше правила учи

Ну а рядом главный блок:
Там бежит электроток
К самым важным микросхемам
Этот блок зовут системным.

Если сбой дает машина, 
Терпенье Вам не обходимо,
Не бывает без проблем 
Даже с умной ЭВМ!

Он считает, он считает,
Сотни слов запоминает!
Он мыслитель хоть куда!
Только знаешь в чем беда?

Выключаешь, все забудет-
Ничего он знать не будет - 
Прямо как Рассеяный
С улицы Бассейной.

Кто ж ему поможет?  Вот
Познакомьтесь – дисковод!
Коль с компьютером ты дружен-
То и справочник не нужен!
В упаковке, как конфета,
Быстро вертится – дискета-
Там записаны программы
И для папы, и для мамы!
Это вот - клавиатура
Вот где пальцам физкультура
И гимнастика нужны!
Пальцы прыгать там должны!

Бережливым быть умей,
И по клавишам не бей,
Там учтите этот факт,
Электрический контакт.

А вот это принтер, братцы,
Тут нам надо разобраться,
Для чего же этот ящик?
Он в себя бумагу втащит,
И сейчас же буквы, точки,
Запятые – строчка к строчке-
Напечатает в момент!
Очень нужный инструмент.

В зоопарке есть зайчишка.
У компьютера есть мышка
Это мышка не простая
Это мышка вот какая:
Скромный серый коробок,
Длинный тонкий проводок,
Ну а на коробке-
Две или три кнопки.

Мышка может другом стать, 
Коль ее не обижать.
Дрессируй ее умело,
Не крути в руках без дела.

Есть компьютер? Скажем прямо:
Нам теперь нужна программа
Где живет она? В дискете!
А порою на кассете.
С ней компьютер очень дружен
И всегда он ей послушен.
И на нем ты скоро сможешь
Составлять программы тоже!

Вот теперь, дружок, немного
Ты с компьютером знаком.
Если дальняя дорога
Приведет его в твой дом, 
То скажи ты всем вокруг:
«Вот компьютер - лучший друг!»

Итак,  садимся все за рабочие места. 

Перед началом любой работы в Photoshop необходимо открыть исходное изображение, 
либо, создать новое. В данном случае мы будем работать с новым изображением. Создайте заготовку произвольного размера в черно-белом (Grayscale) цветовом режиме. Фон на вашем изображении должен быть белым (слайд № 7).
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Слайд 7

Выполнить  команду Файл – открыть (слайд 8)
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Слайд 8

Открыть и вставить  изображение (слайд 9, 10)
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Слайд 9
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Слайд 10
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	Посмотрите на слайд. Как вы могли обратить внимание, эта картинка очень плохого качества. Многие контуры стерты, многие недостаточно прорисованы. Такое изображение взято специально, чтобы продемонстрировать вполне реальную работу «на заданную тему», а не облегченный пример.
Усложним задачу: будем рисовать псевдообъемного мамонтенка, а не стилизованного под графический рисунок.
	Первое, чем следует заняться, это обводка контуров. Дело в том, что мы будем заливать части мамонтенка разными цветами, а если ограничивающие их линии будут прерываться, то зальется не только то, что надо, но и все остальное. Поэтому возьмите простую кисть (Paintbrush) и черным цветом обведите все те места, которые вызывают сомнения. Значительно удобней будет работать, если вместо белого цвета на изображении установить прозрачность. Это делается очень просто при помощи инструмента Magic Eraser (Волшебный ластик). Установив значение допуска примерно на 20, примените этот инструмент к фону и областям внутри контуров мамонта. Лучше сразу не убирать цвет со всего мамонтенка, а ограничиться только тем с чем выбудете работать в ближайшее время, В нашем случае это спина и левое ухо.
	Выберите подходящий цвет спины, мамонтенка. Затем, при помощи Paint Bucket (Заливка)
залейте ее. Результат показан (слайд 11)
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 Слайд № 11
	Можно, конечно, просто залить подобным методом и все остальное. Но мы хотим получить более интересное изображение, чем плоский рисунок. Поэтому придется немного проявить терпение.
	Возьмем инструмент Magic Wand (Волшебная палочка) и, установив нулевой допуск
(Tolerance), выделим залитую спину. Затем скопируем ее на новый слой. Для этого нужно последовательно нажать сочетания клавиш Ctrl+C и Ctrl+V. Забегая вперед, скажем, что в основном это необходимо для дальнейшего применения слоевых эффектов. Превратим коричневую краску в шерсть. Для этого сначала добавим шум: Filter > Noise > Add Noise (Фильтры > Шум > Добавить шум). Примененные настройки показаны (Слайд 12)
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Слайд № 12
	Полученная текстура уже похожа на шерсть. Но все же это еще не шерсть,.. Для окончательного ее оформления примените фильтр Wind (Ветер): Filter > Stylize > Wind (Фильтры > Стилизация > Ветер) (слайд 13).
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Слайд № 13
	Мы добились поверхности, очень близкой к плотной шерсти. Однако, как вы помните,
Наша задача сложнее - добиться эффекта псевдообъема. Тут нам пригодится то, что мы скопировали спину на новый слой.
	Примените эффект слоя Bevel and Emboss (Теснение): Layer > Layer Style > Bevel and
Emboss (Слой > Стили слоя > Теснение). Использованные в данном примере настройки показаны (слайд 14). В результате вы получите достаточно правдоподобную, объёмную спину.
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Слайд № 14
	Вернитесь на первый слой и повторите все вышеописанные действия уже с ухом мамонтенка. Относительно этой части работы можно добавить только то, что для верхней и нижней частей уха лучше использовать два разных слоя. Не станем приводить настройки стиля Bevel and Emboss (Тиснение) - для уха они подбираются без особого труда.
	Несколько сложнее работа с ногами мамонтенка. Их также лучше раскрашивать с помощью нескольких слоев. Настройки объема для правой ноги показаны  на слайде (слайд 15)
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 Слайд № 15
	Стопа рисуется при помощи обычной кисти или инструмента Paint Bucket (Заливка). Круг в ее центре создан инструментом Burn (Затемнитель), но можно обойтись аэрографом. После
этого вы получите примерно то, что изображено на слайде № 16.
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Слайд № 16
	Сразу стоит сказать, что если вы не удовлетворены примененным цветом, то, его всегда можно сменить. В нашем примере неудачно выбран цвет ног. Для того чтобы заменить его на более подходящий, достаточно обычной кисти. Выберите инструмент Paintbrush (Кисть) и новый цвет. Затем измените режим Mode ( кисти ) на Color (Цвет). Это значит, что будет меняться только цвет пикселов, а их яркость останется неизменной. Теперь просто закрасьте ноги мамонтенка.
Аналогичным образом раскрашиваются и все остальные части мамонтенка. Слоев будет накапливаться достаточно много, и поэтому лучше их время от времени склеивать. Труднее всего придется с глазами и слезами. Лучше всего нарисовать их вручную, но если у вас нет художественных способностей, то возможен обходной вариант - использование градиента и дальнейшее применение стиля Bevel and Emboss (Скос и рельеф). В конце работы необходимо подкорректировать все неточности при помощи инструментов Paintbrush (Кисть) и Stamp (Штамп).
У каждого из Вас,  созданный герой будет особенным. Цветовое решение зависит только от вашего воображения (слайд № 17) .
[image: ]

Слайд № 17

Текущий инструктаж (5 часов)
Первый обход рабочих мест.
Цель обхода:
· Проверить, все ли приступили к работе;
· Оказание  помощи учащимся, затрудняющимся приступить к работе.
· Проконтролировать организацию рабочего места.
Второй обход рабочих мест
Цель обхода:
· Оказание индивидуальной помощи учащимся в выполнении упражнений.
· Проконтролировать соблюдение требований охраны труда
· Выявление и устранение допущенных ошибок
Третий обход рабочих мест
Цель обхода:
· Прием выполненных работ
· Подготовка к заключительному инструктажу.
Заключительный инструктаж.(15 мин.)
Мастер производственного обучения отмечает работу каждого обучающегося  и группы в целом, подводит итоги. Ответьте, пожалуйста,  на вопросы (слайд № 18):
· Какая программа использовалась для раскрашивания контурного изображения? (ответ -Photoshop);
· Какие применялись эффекты? (ответ – «шум», «ветер», «теснение», «скос и рельеф»);
· С каким оборудованием работали на уроке? (монитор, системный блок, клавиатура, манипулятор мышь).
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Слайд № 18
Мастер объявляет оценки и благодарит за работу на уроке.
Домашнее задание. Самостоятельно выполнить раскрашивание контурного изображения (образцы заготовок прилагаются, слайды № 19, № 20)
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Слайд № 19
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Слайд № 20

Рефлексия: Оцените полученную информацию на уроке, ответив на вопросы (слайд 21)
Сегодня я узнал…
Было интересно…
Было трудно…
Я выполнял задания…
Теперь я могу…
Я приобрел…
Я научился…
У меня получилось…
Я смог…
Я почувствовал что…

Спасибо за урок. До свидания.
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